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This document provides recommended configurations for running Autodesk®
Vault Professional Server with the Panzura® Global File System (GFS).
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Purpose

This document provides recommended configurations for running Autodesk® Vault Professional Server with the Panzura® Global File System (GFS).
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Background
Autodesk Vault Server is a CAD data management software that helps designers and engineers organize their design data, manage documentation,

and track revisions and other development processes.

One feature found in the Professional Edition is “File Store Replication”, the process used by Vault to copy CAD data across sites but as with all data
replication solutions, it is affected by latency. Panzura adds value by solving the latency problem and eliminating challenges with replication.

Panzura provides global file locking, fast file synchronization, cloud reliability and military grade security; Autodesk Vault users gain the performance

benefits of a global file system without compromising their current workflow.

A general diagram of the solution is presented in Figure 1. Panzura provides general File System functionality, eliminating the need for expensive NAS

=2

arrays and simplifying the integration between sites.
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Figure 1: Two Site Diagram

Pre-requisites
You should have working knowledge of Microsoft Windows Server®, Autodesk Vault and Panzura GFS administration and terminology. This guide

details on how to configure Panzura and Autodesk Vault to work together. Be sure to have proper licenses to deploy this solution.
This document covers the following software versions:

e Panzura GFS version 6.0 or better (in any combination of Physical, Virtual or AMI controllers)

e Autodesk Vault Professional Server 2016

e Microsoft Windows Server 2012 R2 with SQL Server Standard

© Panzura, Inc - 2016.
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Deployment

The variables below in quotes can be replaced with names that adhere to your corporate naming schema.

Phase 1: Install and configure the Microsoft Windows Server and the Panzura GFS

1. Install and deploy a Microsoft Windows Server at each location as per the diagram above.
a. “Site A” - Hostname: VAULT - Services: SQL Server 2014 STD, IS, DFS, Vault Professional Server 2016
b. “Site B” - Hostname: VFS-01 - Services: IS, Vault File Server 2016

2. Install the Master Controller at “Site A” with hostname “panzura-cbi3” as usually done for any master controller, follow the instructions on
the Panzura Storage Controller Installation Guide for instructions.

a. No need to create a specific File System at this stage, a CIFS/SMB share will be configured during the Autodesk Vault configuration
process.

b. Export the CloudFS Configuration to facilitate the configuration of Subordinate controllers

e} H ] ™
o Quicksilver
S

Cloud Storage Controller

Export CloudFS Configuration LS A Y YT RYTRRTRRNN

controller. All other
Cloud! fi

deploymen

CloudFS Configuration File Export File

Back Next

Figure 2: Export the CloudFS Configuration

3. Install the Subordinate Controller at “Site B” with hostname “panzura-cbl4” as usually done for any subordinate controller, follow the

instructions on the Panzura Storage Controller Installation Guide for instructions.
a. Use the CloudFS configuration file as noted in the Installation Guide.

4. With GFS configured and online, you can configure HA capabilities if needed, follow the Panzura Storage Controller HA Best Practices for
instructions.

© Panzura, Inc - 2016. 4
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Phase 2: Configure your Autodesk Vault File Store location

1. Create a SMB Share for your Autodesk Vault Servers
a. Login to the Master Panzura CloudFS Ul to create Vault’s share and enable ABE

¢ Click on the Configuration tab -> CIFS -> Add a CIFS Share: “ADMS” (If you are using Panzura 6.1 or above the tab will be
SMB instead of CIFS)

e Share Name: adms
e Share path: /cloudfs/panzura-cbl3/adms

Dashboard Configuration Maintenance

Basic Settings CIFS Settings

System

Network CIFS Shares

Time Add a CIFS Share Delete Selected
Encryption & Certs Share Name: adms

CloudFs Share Path: /cloudfs/panzura-cbl3/adms

Active Directory

Add
Dynamic Sites
Name Path
CIFS
No table entry found
Snapshot
License Manager Save

Figure 3: Share name: adms , Share path: /cloudfs/panzura-cbl3/adms

e Click on the Configuration tab -> Advanced -> CIFS

e |f you are using Panzura 6.1 or above the menu option is SMB instead of CIFS

¢ Enable Access-based Enumeration (ABE)

Dashboard Configuration Maintenance
Basic Settings CIFS Settings
Advanced Settings
General Settings
System
SMB signing: Off v
KMIP
Encryption & Certs | ;-.ccess sed ® Enable Disable |
numeration:
Active Directory
Hide CloudFS Share: Yes @ No
CIFS
Save

Snapshot Manager

Figure 4: Enable Access-based Enumeration (ABE)
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2. Repeat step 1, but on the Subordinate controller

a. Login to the Subordinate Panzura CloudFS Ul to create Vault’s share and enable ABE, be sure to use the appropriate controller
hostname “panzura-cbl4”

e Click on the Configuration tab -> CIFS -> Add a CIFS Share: "ADMS”
e |f you are using Panzura 6.1 or above the menu option is SMB instead of CIFS
e Share Name: adms
e Share path: /cloudfs/panzura-cbl4/adms
e Click on the Configuration tab -> Advanced -> CIFS
e If you are using Panzura 6.1 or above the menu option is SMB instead of CIFS
¢ Enable Access-based Enumeration (ABE)
3. Open the Active Directory Console

a. Create an Active Directory user account for the Vault Servers to use as the Impersonation Account. Use a descriptive name like;
“AutodeskRemote”

4. Create a DFS Namespace on the first Microsoft Windows Server called “vault”

-~ DFS Management
4 File Action View Window Help
vl BEIR ? Mo: : -

&= 2 = ° - New Namespace Wizard
¢ DFS Management ! :

22 Namespaces P N

- = amespace Server
b % Replication ’.

Steps:

Enter the name of the server that will host the namespace. The

Namespace Server will be known as the namespace server.

Namespace Name and Settings| Server: I
vault
Namespace Type l | !

Review Settings and Create
Namespace

Confirmation

Figure 5: Name the Microsoft Windows Server “valut”
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a. Open the DFS Management console to create the Namespace structure
e Create a Namespace, use a short name like “DFS”

e Create a Shared Folder underneath the “DFS” Namespace. Use a short name like “ADMS”

DFS Managemer

~4 File Action View Window Help
L d[=

<3 DFS Management
H%Z Namespaces
[ @ Replication

New Namespace Wi

Namespace Name and Settings

Enter a name for the namespace. This name will 2
name in the namespace path, such as \\Server\!

Namespace Server

Namespace Name and Settings

Namespace Type

R
N
Cof

Namespace server:

|vaul |
Shared folder:

E2 |
Local path of shared folder:

[C:\DFSRoots\dfs ] [ Browse.. |

Shared folder pemissions:
(O All users have read-only pemissions
O Al users have read and write pemissions

( Administrators have full access; other users have read-only
" pemissions

(@) Administrators have full access; other users have read and write
= permissions

O Use custom permissions:

Figure 6: Create a Namespace, use a short name like: “DFS”

b. Select “Stand-alone namespace” and verify that the newly created namespace “\\vault\dfs” is on the “Preview of Standalone

Namespace” box

4 DFS Managemer
~4 File Action View Window Help
e = = 3 New Namespace Wi
< DFS Management -

52 Namespaces

_ N T
3 3& Replication lamespace Type

Select the type of namespace to create.
Namespace Server ~

(O Domainbased namespace
Namespace Name and Settings A domain-based namespace is stored on one ¢
Domain Services. You can increase the availa
Namespace Type muttiple servers. When created in Windows Se
Review Settings and Create increased scalability and access-based enume

Namespace

Confirmation
Preview of domain-based namespace:
\\ad.cadable com'\dfs

@® Stand-alone namespace

A stand-alone namespace is stored on a single
availability of a stand-alone namespace by hos

\\vault\dfs I

I Preview of stand-alone namespace:l

Figure 7: Select: “Stand-alone namespace”
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c. Right click on the Namespace name \\VAULT\dfs and click on Properties.
e Enable “access-based enumeration” and save

P

K

‘74 File Action View Window Help
| 2@ 3|

b ga Namespaces
b a Replication

Name
&4 \\VAULT\dfs

Access-based enumeration hides folders in this namespace that users
do not have pemission to view.

[w] Enable access-based enumeration for this namespace

d. Right click on the Namespace name “\\VAULT\dfs” and create a New Folder “adms”

74 File Action View Window Help

o= z[E B
amespaces

& WAULTd#s | ||| Nemespace [ Namespace Servers | Delegati

o J—JWFolder... I

Delegate Management Permissions...

Remove Namespace from Display...
View »
New Window from Here

Delete
Refresh
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e. Right click on the new folder “adms” and select Properties

e Click on the “Clients fail back to preferred targets” and click “OK”

2 DFS Managemen

2y
74 File Action View Window Help

e 2
«:;‘] DFS Management \\WWAULT\dfs (Stand-alone namespace)

4 4 Namespaces - — S
4§53 \\AULT\dfs [ e [ —
5 adms 1 entries
b &Y Replication Type | Name

Se adms

General | Refemals | Advanced

Specify the amount of time that clients cache (store) referrals for this
folder.

Cache duration (n seconds):
This folder inherits settings from the root. Click a check box to
overide the namespace settings.
[] Exclude targets outside of the client's site

Effective refemral ordering:

Lowest cost

[w] Clients fail back to prefemed targets
Effective failback mode for clients:

[Enabled |

OK Cancel Apply

f. If the wizard does not request a “New Folder Target”, right click on the new folder name “adms” and add a New Folder Target

e Use the path to the Panzura Share you created in Phase 1: “\\panzura-cbl3\adms” and click “OK”

M DFS Management

T
74 File Action View Window Help

<% 27 HE

4 DFS Management
4 ,"ﬁ Namespaces
4 3 \\VAULT\dfs
a7 adms
[ a Replication

Namespace path:
\\VAULT\dfs\adms
Path to folder target:

|\\panzuta4;;bl 3\adms|
Example: \\Server\Shared Folder\Folder

B Properties
Help

© Panzura, Inc - 2016.
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g. The wizard will require input for “Replication”

e Click on “No”
e
5 File Action

e xnm B

:5 DFS Management
4 ;gi Namespaces
4 3 \\VAULT\dfs
a7 adms
[ % Replication

DFS Management

View Window Help

Folder Targets | Replication

1 entries
Type | Referral Status | site | Path
E' Enabled Default-First-Site-Name \\panzura-cbl3\adms

A replication group can be used to keep these folder targets
synchronized.

Do you want to create a replication group?

No

h. Right click on the “adms” folder and select “New Folder Target” to add the share from the Subordinate controller “panzura-cbl4”

to the Folder Target list.

‘Zy File Action View

DFS Management

Window Help

= 7(m

(% DFS Management
4 & Namespaces
4 25 \\VAULT\dfs
7 adms
b & Replication

Namespace path:
[\WAULT\dfs\adms

Path to folder target:
|\\panzulacbl4badms
Example: \\Server\Shared Folder\Folder

i. After these steps, the Folder Properties should appear as shown below, showing the “adms” folder with two targets

4 File Action

e 2@

View Window Help

(?j DFS Management
4 3 Namespaces
4 53 \\VAULT\dfs
4 adms

b % Replication

Type | Referral St... | Site | Path

& Enabled
™ Enabled

Defaut-First-Site-Name
Defautt-First-Site-Name

\\panzura-cbl3‘\adms
\\panzura-cbl4\adms

© Panzura, Inc - 2016.
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j.  On each site verify that DFS points to the appropriate controller

Open the DFS Management console and right click on the “adms” folder and select Properties, click the DFS tab.

© File Action View Window Help
«=| z(m B[m

4 k3 Namespaces
4 5 \\VAULT\dfs
&3 adms
b &Y Replication

Folder Targets | Replication
2 entries

Type Referral Status | Site

Default-First-Sit...
I Enabled Default-First-St...  \\panzu
& adms (\\vault\dfs) (V:) Properties

‘ General l Security l Previous Versions | DFS | Customiz L

lv:‘-..

Referal list:
Path Active Status
Q\\panzumchl 3\adms Yes

#-J\\panzura-cbl4\adms No

The server on Site A, VAULT points to the Panzura controller on Site A: panzura-cbl3

The server on Site B, VFS-01 points to the Panzura controller on Site B: panzura-cbl4

> adms (\\vault\dfs) (V:) Properties
| General l Security | Previous Versions DFS ’Customize
IV:'\
Referral list:
Path Active Status
2_-;; \\panzura-cbl3‘\adms Yes
| j & \\panzura-cbl4\adms No |

Hos tname

& adms (\\vault\dfs) (V:) Properties
| General l Security | Previous Versions DFS ’Customize
IV:"".
Referral list:
E‘ath Active Status
i;] \\panzura-cbl3\adms No
&3 \\panzura-cbl4\adms Yes
\

Best Practices Guide
USING THE PANZURA GFS TO ACCELERATE AUTODESK VAULT
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5. Configure the Panzura CC to bypass FileStorelnfo.fsg*

a. Login to the Master Controller CloudFS Ul and click on the Maintenance tab -> Diagnostics and in the Diagnostics Tools section,
select: cifs-add-gcfg

Note: If you are using Panzura 6.1 or above the option is smb-add-gcfg
¢ Inthe “Enter Parameters” box, type:
pz-replock local files = /Thumbs.db/.DS_Store/”.smbdelete/.fsg/

¢ Click “RUN”

e Repeat this routine on every Panzura Cloud Controller that has an Autodesk Vault Server connected to it.

Dashboard  Configuration Maintenance
Maintenance Di agnostics
Diagnostics

CIFS Dashboard
asnbeat Packet Capture Tools

CIFS Users
pkt-capture v gbl v Start Stop
CloudFS
Diagnostics Tools
Cloud Metrics
Command Type Enter Parameters:
Master Snapshot cifs-add-gefg v | pz-replock local files = /Thumbs.db/.DS_Store/*.smbdelete/.fsg/ Run

d
Image Upgrade Diagnostics Output

Reboot

- _

This step is required to stop the synchronization of the “FileStorelnfo.fsg” file between controllers. Each Vault Server must own its working file to

maintain a healthy system. If the Panzura controllers modify this file, Vault will interpret the remote update as a corruption of the file and will stop
working properly.

Phase 3: Configure Autodesk Vault File Server (AVFS) Connectivity

1. Establish connectivity from AVFS to ADMS

a. Start AVFS Console

A A Autodesk Vault File Server Console 2016 = | =
: File Tools Actions Help
Search Help
= [g] VFS-01 Y Log In -
7 Vaults
= F7] Management i —
F Console Logs User Name: [ dministrator I
File Store L
B3 File Store Logs Password: I ]
[T] Windows Authentication
’ oK I | Cancel I ‘ Help ‘

1. FileStorelnfo.fsg is a static file that is unique to each instance of Autodesk Vault. This file does not need to be kept in sync across Panzura Controllers, unless Autodesk

Vault is re—inst_alled on the master APMS. Maintaining this file independent from the GFS allows each Vault Server to use a sin.gle directory as it_s File Store.

© Panzura, Inc - 2016.
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b. Tools -> Administration -> Basic

Enter the hostname or IP address of the master vault along with Administrator level credentials

A Autodesk Vault File Server Console 2016 =& x
i File Tools Actions Help B
_- Search Help @ !
= [g] vrs-01 .
= B Vauls Autodesk Vault File Server
@ Vault On VFS-01
= 7 Management

# [ Console Logs K2

Settings
# [ File Store Logs

Server configuration settings Settings...

Ak A

pA Server Configuration -
Settings...
ADMS: I ’http:/_/vault.cadable.com/ }I
| Close I | Help
User Name: m I
Password: l J
[T] Windows Authentication
| oK | | Cancel | I Help | l >
@ Administrator

c. Tools -> Administration -> Advanced
d. Set your Impersonation Active Directory username and password

e. Set the initial File Store location to reside on a local drive of the AVFS

X Advanced Settings B

Impersonation

User Name: ad.cadabIe.com\administvator|

Password: “ |

Connection
Connection Timeout: 1000 Seconds
Log File Configuration

Limit the number of log files before they are recycled. Value must
be between 6 and 99.

[] Maximum number of console logs: 6
[[] Maximum number of server logs: 6

Reset Defaults

oK Cancl || Hep |

© Panzura, Inc - 2016. 13
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2. Move the AVFS File Store to the DFS Share
a. Inthe AVFS console from the left navigation pane:

e Click on desired Vault

{ File Tools |Actions | Help

| Move File Store... |
= [g] vFs-0 Vault Enabled

EEIVa T Refresh FS Vault

Wy On VFS-01
= FJ Management

= F7 Console Logs
Today - 12/19/2015
= 7 File Store Logs
Today - 12/19/2015
Archive - 12/18/2015 Created By Administrator
Archive - 12/17/2015

Created Date 8/18/2015

File Store Ci\vaultserver\filestore
Number of files in store 3187/ 3194
e select “Move File Store”
e Enter: \\server_name\dfs_share_name
A Autodesk Vault File Server Console 2016
¢ File Tools Actions Help
= (5] VFs-01
S £ Vauls . Vault
@) Vault On VFS-01
= 7] Management
= ] Console Logs
Today - 12/19/2015 Created Date 8/18/2015
= 7 File Store Logs
Today - 12/19/2015
Archive - 12/18/2015 Created By Administrator

Current File Store Location: |C:\vau|tserver\filestore

New File Store Location: |\\vau|t\dfs\adms\|

© Panzura, Inc - 2016. 14
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Phase 4: Point the master ADMS server to the DFS Share

1. Shut down the Autodesk Data Management Job Dispatch service on the AVFS and clear the DFS Share so that the main server can move its
File Store into it

a. Disable Autodesk Data Management Job Dispatch service on AVFS
e Open Services Console, run, services.msc at the command prompt

e Right click “Autodesk Data Management Job Dispatch” and click on “Stop”

File Action View Help
e m Bz HE »enop

-~

% Services (Local) Name Description Status Startup Type  LogOnAs
., App Readiness Gets apps re... Manual Local Syste...
., Application Experience Processes a... Manual (Trig... Local Syste...
. Application Host Helper Service Providesad... Running Automatic Local Syste...
’.,-, Application |dentity Determines ... Manual (Trig... Local Service
’,,3, Application Information Facilitatest... Running Manual (Trig... Local Syste...
o) Application Layer Gateway Service Provides su... Manual Local Service
o'} Application Management Processes in... Manual Local Syste...
. AppX Deployment Service (AppXSVC) Provides inf... Manual Local Syste...
| g ; R Manual Network S...
{ 4 Autodesk Data Management Job Dispatch i i Automatic Local Syste...
. AWS Lite Guest Agent Automatic Local Syste...
. Background Intelligent Transfer Service Manual Local Syste...

“, Background Iasks Infrastructure Automatic Local Syste...
7}, Base Filtering Engine Automatic Local Service
% Certificate Propagation Manual Local Syste...
£ CloudFormation cfn-hup Manual Local Syste...
4. CNG Key Isolation All Tasks Manual (Trig... Local Syste...
’:ﬁ COM+ Event System Refresh Automatic Local Service
4, COM+ System Application i Manual Local Syste...
i Computer Browser i Disabled Local Syste...
% Credential Manager Help Manual Local Syste...
. Cryptographic Services Providesthr.. Running Automatic Network S...

£, DCOM Server Process Launcher The DCOM... Running Automatic Local Syste...

- .. P

Extended A Standard /
Stop service Autodesk Data Management Job Dispatch on Local Computer

© Panzura, Inc - 2016. 15
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b. Delete the files on “DFS” Share that “AVFS” created, the system will use the files from the master vault

e Using the Windows File Explorer go to the “ADMS” drive, right click on the “Vault” and select Delete.

Hostname VAULT

-'rn | VA

“ Home Share View o
©) - 1 ’5_!’ » computer » adms (\\vault\dfs) (V:) » v ¢ Search adms ault\df... P ]

A —— _ e _ Y=
Y Favorites Name Date modified Type
Bl Desktop Vault 12/19/2015 234 AM  File fg

8 Downloads Open

| Recent places Open in new window

Restore previous versions

Bl Desktop Pin to Start
A cadable Send to »
1™ computer _
m Desktop - ot
Documents Copy
& Downloads
B Music Delete ‘
= Pictures o
Videos Properties

&y Local Disk (C:)

a adsk-mag (D:)

L# adms (\\vault\dfs) (Vi)
Vault
. _uploads
, 000

We delete the VFS File Store on the “DFS” share “ADMS” so that the main Vault Server can move its File Store in the “DFS” share location. The Vault
system will not move the File Store into a directory that already has a File Store in it because the directory structure of the main Vault Server and the
VFS-01 is identical.

Another reason to do it in this order —VFS-01 first, Vault second-, is because the VFS starts with a partial copy of the data and completes itself upon
next sync and as files are needed for that site. The main Vault Server is the complete copy of the Vault, so we would want to move it to the “DFS”
share last. If multiple “DFS” servers are involved, do all of them one by one, shutting down the previous server as you move to the next one, then the
main Vault server last, then start them all up.

© Panzura, Inc - 2016. 16
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¢. Move main ADMS File Store to DFS Share
e Run ADMS Console on master ADMS
¢ In the left navigation pane, right-click on the desired Vault and select “Move File Store”

¢ \\server name\dfs share name

: File Tools Actions Help

5] VAULT
- g 7] Vaults Vault
@

On VAULT

7] Libraries
£ Manage
@ Workgro
(@ File Sto

Detach...
Delete...

Created Date

Move File Store... |

Created By

Purge ltems...
2. Start Autodesk Data Management Job Dispatch on VFS
a. Open Services Console, run, services.msc from the command prompt

* Right click on “Autodesk Data Management Job Dispatch” and click Start

File Action View Help

e E ez Hm »eanwp

% Services (Local) || Name “ Description  Status
Ck App Readiness Gets apps re...
o'} Application Experience Processes a...
%Application Host Helper Service Provides ad... Running
:;',Application Identity Determines ...
o/} Application Information Facilitatest.. Running
.’;,Application Layer Gateway Service Provides su...
(%, Application Management Processes in...
ig",Apr Deployment Service (AppXSVC) Provides inf...
%, ASP.NET State Service Provides su...
£#3 A utodesk Data Management Job Dis )2 2
(. AWS Lite Guest Agent Start
) Background Intelligent Transfer Serviles —
Q, Background Tasks Infrastructure Service Pause ng
CJ Base Filtering Engine S ng
Cff',Certificate Propagation Restart ng
4 CloudFormation cfn-hup
4% CNG Key Isolation All Tasks ’
(}, COM+ Event System Refresh ng
(%, COM+ System Application )
:-e, Computer Browser Peapertos
(%, Credential Manager Help
f..e, Cryptographic Services Provides thr... Running

© Panzura, Inc - 2016. 17
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3. Fine tuning
a. Start ADMS Console on master ADMS
e Right-click on Workgroup objects that point to DFS Share
e Setreplication schedule to 1 hour intervals

Y Autodesk Data Management Server Console 2016
: File Tools Actions Help

= [§] VAULT
1 vous 5 VFs-o1
@ vaurt
[ Libraries
5 Management
'?D Caognsolce Logs Vault Vault Status Site Replication Type Locatio
% [ ServerLogs » Vault Enabled Frequency \\vault\
¥ [ File Store Logs
) Email Logs T
5 @ Workgroups Y Scheduled Replication -
= [{Z] VAULT\AUTODESKVAULT
VAULT [ Enable scheduled replication
= () File Stores
- VAULT Recurrence Pattern
@ vault
2 3 vrs-on O Daily
1] m Every: |1 z hours v
(® Frequency
Start Time
12:00 AM -
Replicated Folders oK Cancel ‘ { Help

You have now configured Autodesk Vault to take advantage of Panzura’s performance for cross-site collaboration! The image below illustrates the end

user view of the Vault using the GFS on the host Vault. It will appear the same on VFS-01 or anyother configured host.

VAULT

A A Autodesk Data Management Server Console 2016 Drive Tools VA = X
I File Tools Actions Help B e Manage (7]
g o [IJ_! e b adens (\\vaul\dfs) (V:) v ¢ f.. P
5 (5 VAWLT A -
= £ Vauls » | Vault N~ -
@ = On VAULT . .
Vault
[7) Libraries - .
# ] Management - adms (\\vault\dfs) (V) Properties X |
+ (9 Workgroups Conbed Dida e —
% (T Fie Q0res - : o Gerwenl | Secuty | Previous Versors | OFS Customize
Created By Administrator
Rederl kst
File Stoee vault\afs\adms\Vault B Path Active ea
- 89\ vanauractiT adms Yes
89 \\panauracbid\adms No
Database Sce 352 MB |
File Store Size 701.25MB
Number of Files in Store I
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USING THE PANZURA GFS TO ACCELERATE AUTODESK VAULT

Additional Considerations

The use of the Panzura GFS as the file system infrastructure for Autodesk Vault reduces the wait between project creation/modification and files

accessibility on a secondary site from hours to seconds.

When a user from a remote site tries to access a file within the “1 hour” replication window as configured in the step 3 from the last phase, the user
will see a message from the server: “Do you want the local server to get a copy of the file?” click on “Yes”.

Clicking “yes” for your server to get a local copy will not actually trigger a re-copy of the file. Panzura will accelerate copying the file via the GFS and
the Vault Server will mark the file as downloaded almost instantly.
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